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The following icons appear in the user manual:

The information icon precedes important information.

& | The example icon indicates a practical illustration of a process or procedure.

The hint icon indicates a suggestion or hint to guide or assist you with performing a
task.

v | The warning icon provides a warning against potential mistakes and actions that could
~ | cause critical error.
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The Plug-in Installer allows you to upgrade exsting Server Edition (SE) Backup Clients with
added functionality by installing application -specific plug-ins and other monitoring tools. You
can also upgrade existing plugins with this installer. As from Attix5 Pro v5.0, plug-ins can also
be auto-updated during the backup process, if enabled on the Storage Platform

The SE Client must be installed on the computer before you can install any plug-ins. SE plug-
ins require working space for the cacheand disk space for creating a data dump and patches.

e
~

Ensure that the drive on which the SE Client is installed has enough free hard
drive space to store an extra copy of all the selected files. If not, move the ToBackup |,
Cache and dump foldersto another drive.

The application that the plug-in will be working on does not have to be installedbefore installing

the SE Client. Simply run the Plug-in Installer executable and supply the necessary information.
The installer will prompt you to close the SE Client interface, if it is open, when running the

Plug-in Installer. The installer also checks various requirements (such as operating system and
MS .NET Framework installation) and adds a note next to the plug-in nhame should the
requirement not be met.

B Plug-in Installer

Select the plugins you want installed.
Plug-ins marked with a“ are already installed on the system.
Plug-ins marked with a* will be upagraded.

Email Notification

O

100

Exchange 2003 Single Mailbox Recovery
[[]  Exchange 2007 Single Item Recovery
[[]  Exchange 2010 Single ltem Recovery Plus
[1  Lotus Domino 6.5/7
[]  MS Exchange Server 2003/2007
[]  MSSOL Server
[1  Oracle 9i/10g
[ Script
(] Sharepoint
[]  System State
[ YMware20 [ESX 3.5)
[ YMware5 [ESX 3.5)
] VMware50 [ESX 3.5)
[ YMwarePlus (ESX 3.5)
[]  ¥SS [Exchange 2003/7/10, MS SOL 2005/8)

ATTIX Pro

Attintnstaller

Back |

Close I
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The installer will detect the current SE Client installation location and confirm it as part of the
installation process

A list of available plug-ins will enable you to select the plug-ins you wish to install and/or
configure. Plug-ins marked with © are already installed on the system. Any plug-ins marked
with a © blue icon will be upgraded to the latest plug-in version.

Select or deselect any of the plugins by clicking in the checkbox next to the plug-in name. After
you have made al the necessary changes, clickNext . The nextstep in the wizard will display a
summary of all the changesthat you have requested.

Click Apply requested changes to continue with the upgrade or Back if you want to modify
your selection.

The Plug-in Installer stops the SEClient service, install s'upgrade s/uninstall s the selected plug
ins and starts the service again. ClickFinish to close the application. After installing the plug -
ins, open the SE Client and configure the installed plug-ins. For more information about the
plug-ins, s ee Chaptemsd, .bfePlowg

i As a precaution, the Plug-in Installer does not remove the dump folder used by
the plug-ins or any plug -in-specific settings when you remove plug-ins. You have to
remove it manually if needed.
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Adding to its features and functionality, Attix5 Pro Server Edition also provides a solution for
numerous databases and applications. These solutions are provided as plugns to the Server

Edition of the Client software.

Once installed, plug-ins display in one of two areas of the & i@ Backup Selection | 3l Restore
Client application: in the Backup Selection tree or in a _ -
) ) ) i i . 4l My Computer
dedicated dialog box. Plug-ins available in the selection tree 843
can be selected/excluded for backup in the same manner as -}~ $Recyde.Bin
all other items in the tree. Plug-ins available in dialog boxes G- ATI
. . . [} Backups
can be enabkd/disabled/configured via the Tools menu. i
@-'l/ Logs
(-} = MSOCache
The table below lists the plug-ins included in the SE Client -}~ PerfLogs
(in the same order as displayed in the Graphical User (-} ' Program Files

Interface), alongside the section numbers in this chapter that

describe them.

Server Edition Plug -ins currently available

Email Notification

Exchange 2003 Single Mailbox Recovery
Exchange 2007 Single Item Recovery
Exchange 2010 Single Iltem RecoveryPlus
Lotus Domino 6.5/7

MS ExchangeServer 2003/ 2007

MS SQL Server

Oracle 9i/ 10g

Script

SharePoint

System State

VMware (ESX 3.5)

VSS (Exchange 2003/7/10, MS SQL 2005/8)

V2.13 Dialogue
V3.6 (SMR) Dialogue
V19 (SIR) Tree
V1.0 (SIR Plus) Tree
V2.8 Dialogue
V2.19 Dialogue
V3.8 (2000/2005/2008) Dialogue
V2.9 Tabs
V15 Dialogue
V3.3 (2003/2007/2010) Tree
V3.1 Dialogue
V1.1(20, 5, 50 & Plus) Tree
V2.7 Tree

y Note: Only plug -ins that appear in the selection tree can be used in secondary backup

sets.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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The Email Natification plug-in enables you to receive email notification on backup activity. You
can configure the plug-in to notify you on a specified email address when a backup has been
successful, when it failed or both. The level d information can also be specified.

Please refer to the Attixs SE Client User manual seeing that thisplug-in comes
standard with every SE Client installation.

This plug-in has been included in SE installers since v4.2. If it is not installed, run the Plug-in
Installer and select the Email Notification plug-in.

i) The Plug-in Installer will run automatically during the SE Client installation if
located in the same folder as the Client MSI.

To configure the email notification
plug -in: ¥ Use email notification
1. On the Tools menu, point to Plug - ¥ htify me when a backup fails
inS , and then CliCk Emall Messages Subject: |Backu|3 Failed
NOtifiCﬁtion ¥ Motify me after a successful backup

. o . Messages Subject: IBackup Compleked
2. Select theUse email notification

check box to enable the plugin.

¥ append the subject line with the following options and message

¥ WWarnings v Errars Iencountered, Flease check Log
3_ Select the types of notifications to e.9. Backup Completed - WWarnings, Errars encountered, Please check Log
. . . Mail settings
be emailed. The following options : :
Tot |adm|n@yourdomaln.com
are a\ﬁllable: From: |backup@yourd0main.com
NOtIfy me When a baCkup SMTP server: |smtp.yourdomain.com
fa"s [~ My SMTP server requires authentication
Notify me after a successful e |
Password: I
backup

Test |

Append the subject line
with the following options
and message:

Attachment settings
% Summary, warnings and errors
Warn I ngs i~ Entire Iog file {as per Advanced Options log level setting)

Errors I Backup selection report

Ok | Cancel |
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You can modify the Email subject and content for each of the options by
clicking in the relevant message box, and then editing the text.

The Backup Account name is automatically included in the subject, e.g.
AfBackup Completed [Backup Account n¢e

4. In the Mail Settings area, type To and From email addresses in the fields provided and
supply the SMTP serveraddress and authentication information if necessary.
; In the SMTP Server box, you can specify the SMTP Server name in
isolation (e.g. mail. company.com) or you can inclu de the port number

(e.g. mail. company.com:80).
When no port is specified, 25 will be used by default.

5. Click the Test button to verify that the settings are correct. A test email will be sent to
the address specified in the To field and a message will gppear confirming if the email
was sent successfully. Click OK to close the message and return to the Email
Notification  settings dialog box.

6. Select theAttach file s check box to include a log fileand/or report as attachments.

7. Inthe Attachment settings area, selectfrom the following options:

Summary, warnings and errors
Entire log file (as per Advanced Options log level setting)
Backup selection report T Provides a summary of the backup selection
8. Click OK to save the settings and close theEmail Notification settings dialog box.

The email notification plug-in is how activated and will start emailing reports during the next
backup.
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The SMR plug-in is used to backup and restore single Exchangeserver mailboxes. The SMR
plug-in makes use of a robust Exchange tool called ExMerge to perform the backip and restore
operations. However the plug-in presents a user interface facade to the ExMerge settings file
(usually exmerge.ini) so that ExMerge can be configured from the Attix5 Pro SE client. Once
configured, ExMerge can besnotregaire userintetactianc hé mode t hat

SMR does notrequire MAPI or a MAPI profile to perform its functionality as the plug -in makes
a native call via the COM component to query LDAP for the list of Exchange mailboxes. The
SMR plug-in supports Exchange 2003 only.

To install the SMR plug-in on an existing SE Client, run the Plug-in Installer and select the
Exchange 2003 Single Mailbox Recovery plug-in.

Additional files are created after running either SMR Backup, or SMR Restore, but these will be
detailed later in this chapter. These files pertain to ExMerge settings with SMR Backup files
having a 6smrb_6 prefix, and SMR Restore files havi.

You have to change theAttix5 Backup SE Service Log On during start-up from the Local
System accourt to an account with adequate permissions/administrative rights on the server to
access the Exchangdnformation Store. Open the Computer Management console by right-
clicking on the My Computer icon and selecting Manage . Expand the Services and
Applications section and click on Services. Right-click on the Attix5 Backup SE Service
and select Properties . Click on the Log on tab, select an Administrator account and supply
the log on password.

Microsoft Exchange 2003 note : You must add an ExMerge security group to the server if
you are using Microsoft Exchange 2003. Add this group by selectingActive Directory Users
and Groups from the Administrative tools menu in the Control Panel . The user that you
selected for the Attix5 Backup SE Service  start-up must be added to this group.
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SelectPlug -ins from the Tools menu and selectSM R Backup . Enter the details as indicated

in the dialog box (screenshot available on the following page). Folder to backup to : Specify

where the mailbox PST&ds must be st dpstbatkups bySMR wi | |
default but this can be modified to any location visible on your server, including mapped drives.

Exmerge appends a PST file with the changes since the last backup. The file may therefore
increase during each backup and Exmerge cannot reduce the size of te PST file. TheDelete
existing PST files  option enables you to specify that existing PST files must be deleted during
the backup process. A smaller file will be generated and compared with the copy in the Cachdo
create the patch. This tion is especially useful after reducing mailbox limits/sizes in the
Exchangeserver. Click onCustomize to specify which days of the week you wish to delete the

PST files in the dump folder. Al |
days are selected by default. EoitieialbacEuy
Folder name:; |C:'|,Pr0gram Files\Attix5 Backup Professional SEvpstbackups | | Browse
User mailboxes to back up : Here [] Delete existing PST files in dump Folder prior to backop
you must provide the name of your User mailboxes to back up
Exchange server in the Server Server name: | DEVERCH2 |
Name t ext fi el Mddawvéd {he o S
andenbve 8 buttons ar e™used to e
iy, ..
select/remove the Exchange i
mai |l boxes. Add&enadthe 0 |
below.
Localization. .. | I Check Configuration.. .
. Exmerge Logging
The Verify button can be used to
. |1 Ralllog files larger than
verify ~ whether the  selected
mailboxes are in sync with Active Exmeraz logaing level: |pinimun (1) v |
Directory. The plug-in will list any
o _ _ ok || concel |
missing mailboxes and provide you

with the option to remove them from
the list.

Use the Localization  button at the bottom of the SMR Backup window in case you are
experiencing problems connecting to the ExchangeServer.



ATTIX®

The Check Configuration button
determines whether the SE service
has sufficient permissions to access
Exchangeand the SMR Configuration
Results page will provide in depth
information about the configuration,

and possible permission issues.
Please ensure that your service
account or one of its associated
groups is in the list of trustees with
Send-As and ReceiveAs rights set to
Allow .

If it is not, you will have to correct
your account configuration. Failure
to do so may compromise your SMR
backups.

[31SMR Configuration Results

Flease ensure that your service account or one of its associated groups is in the list of

trustees with Send-As and Receive-As rights set to ‘Allow’,

If it is in the lisk of trustees with these rights set to 'Deny’, you will need ko correct

yaur account configuration,
Failure to do 5o may compronise youl

SE Service Information

r SMR backups,

This information refers to the backup service thak controls SMR.,

SE Serwice account:

JNexmerge

x|

Group memberships:

Damain Lsers

Exchange Server Information
Server name: DEVERCHZ
&0 Path:

Trustees with Send-As set to Allow':

LDAP: [ fiCN=Mailbox Store (DEVEXCHZ), CH=First Storage Group,Chi=

Trustees with Receive-As set to ‘Allow':

EXCHDEY\exmerge

EXCHDEY\exmerge

Trustees with Send-As set to ‘Deny':

Trustees with Receive-as set to 'Deny’:

EXCHDEYY Administrator
ExCHDEY\Domain Admins

EXCHDEY\Exchange Domain Servers
ExiZHDEW\ Administrator

EXCHDEVYEnterprise Admins EXCHDEW\Domain Admins

EXCHDEY\Enterptise Admins

The one gxception to this is if your SE -
account is setup as LocalSystem. In

t his case, the &éCheck Configurationo
feature will simply warn you that it is set to LocalSystem. The onus will be on you to ensure that
LocalSystem is sufficient, or whether you need to setup a unique account for your SEservice.

Exmerge logging option enables you to specify the level of information logged in the Exmerge
logfile. You can enable log file rolling and a log file retention period to limit the space required
by these logs. Note that the plugin will process these options before each backup, so files may

exceed their size, until the next backup.

Cl i c kAdtdhée bout t on to retrieve a |list of available us
shown below.

Sel ect t he uvAvadable usérsdo m EEENEE = |

list by selecting the users and clicking the _— ::*"“b'“‘“*”““m“;:;:xr‘“

Add>6 button to add thegm.to the |ist of 5|

®elected userd . @K to cekurn to e

the previous dialog. The selected users :‘;;;‘:‘: _wi> |

will now be shown in the list of mailboxes Tast Accaint = Rt

that will be backed up (as is shown in
image to the right). =| |




Once you have completed your selection, click theOK but t on RackuptShtings® di al og
your i i C

box. This wil!l store

Backup Settings
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settings in a .

The settings you selected are stored intwo files in the <SE Root Dir>. These files are:
smrb_exmerge.ini T this is the main settings file that ExMerge will use for the backups
smrb_mailboxes.txt i this indicates the mailboxes you selected from the list of available

user mailboxes

Once you hawe completed your first backup, you will find an additional log file in the directory
where you indicated your mailbox PST files to be stored:

smrb_exmerge.log i

this file provides detailed information about the backups

performed and can be examined if anyerrors are suspected to have occurred

Output during a Backup

When you initiate a manual backup, you will
see the following output as evidence that the
SMR plug-in is doing its job.

During the backup, when the line:
fiLaunching E xappearsg @0 the
output, you will also notice an additional dialog
box, from ExMerge, will be launched for the
duration of the SMR backup. This dialog box
provides details about the ExMerge backup in
progress.

Once the ExMerge backup has completed, this
dialog box will be closed automatically.

i) This dialog box does not appear
for automatic backups.

S Sedection =
Corsching b séavics

St tieg Loy

Srarting SR Backup

Lairechang ExMenge

Eaxbar s wsited successhully

SRR backap complate

Savineg sebaction kst

iChesching Fing s e

Tokal selection: 21,56 MBin |7 fles

Chcking cache

Crastirg patchas

WAdding resw filas

Total backup size: 26,1 KB

Trdtiakizine SHUfe Fandom generabor., ..

Coremclinn] ko seever

(e Pt Bl Saruar Diserud Basds LT Skalanbasch _'I

[ ]

I

x

Cipwyeray clats froen the Exchargs Senvet MTE b PST Bet in T \Progen
Filesh&5 Backup Profesional SE\psthackups'

Copy Statiabcs ——

Copy shated st 171422
Elapaed Tima: | 0000004
Workirg on Malbox 5 ol B pelectad
SEENENENEEENENENEENENEER

Moo information

Peasfuming Step:c  Copying fiom S erder Madbos bo Pessonal Foldars:
Cunond Molbox  Steaphan Thiel

Curcerd Foldar  \Sark hems

Successes: 4
Fohusos: [
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Unli ke the SMR  Backup
functionality, which effectively

configures the backup settings to
be used at a later stage (either
when an automatic backup runs,
or the user manually requests a
backup); the SMR Restore
functionality shou Id only be used
when an actual restore operation
is required.

Select Plug -ins from the Tools
menu and then SMR Restore .

Folder to restore from

Localizakion. .,

[5]1SMR - Restore Settings x|

Folder to restore from

Folder name: |C:'I,Program FilesiAttixS Backup Professional SE'I,pstbackups| Browse

User mailboxes to restore

Destination server: |DEVE><CH2 |

testl-2 & | odd. ..

testz-2
besk3-2 Remave
werify. ..

-

Exmerge logging level: | Medium (2) W

| Restore || oK || Cancel |

: This indicates the folder where the PST files can be found thatmatch

the user mailboxes you selected for restore.

User mailboxes to restore

: This is where you indicate both the server to which the PST files

should be restored, and the available mailboxes that should be restored. Only previously backed
up mailboxes available in the specified folder will be in the list of available mailboxes. You can
use the Verify button to determine whether the mailboxes you are about to restore, actually
exist in Active Directory, as this is a requirement of a successful restore.

As per the SMR Backup instructions
specified above, indicate a
destination server in the
Destination  server text field and
click the Add Us e budten.
Select the users from the Available

users list by selecting the users and
clicking the Add > button to add
them to the list of Selected users

Click OK to return to the previous
dialog. The selected users will now

(P Select User Mailbawes X
Wiser thee lists beebow ko sedack thee iser madboes you wesh o restore,
Mrailable users: Seletiod users:
izt akoe | Test Accourk =
Ankhony Enight:
DCuarryd Ptz
Kiobaus Grobler Add =
aphan Thsl
< e
= =
o | coa |

be shown in the list of mailboxes that will be restored (as is shown the previous image).
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Once you have competed your selection, click the Restore button on the Restore Settings
dialog box to begin the restore operation. This will store your settings in an .ini file and launch
ExMerge to perform the restore operation.

Restore Settings

The settings that are savel prior to the restore being launched are stored in two files in the <SE
Root Dir>. These files are:
smrr_exmerge.ini 1 this is the main settings file that ExMerge will use for the restore
smrr_mailboxes.txt i this indicates the mailboxes you selected, tobe restored, from the
list of available user mailboxes

Once you have completed the restore, you will find an additional log file in the <SE Root
Directory> as follows:
smrr_exmerge.log i this file provides detailed information about the backups
performed and can be examined if any errors are suspected to have occurred.

Output during a Restore

Af ter you click O RO Mamare
restore settings are saved, ExMerge
will launch to perform the restore. You
will see the following output during the Copry Slalictics

Mesigrsy dlada fiom P5T et in C\Preorss Flas\imeS Backup
Professonal SE\pribackups’ ba the Exchargs Serves HT4'

fth . Copy stawed o | 171226 Succesres: 3
process 0 _t e restore operation (see Ecsod Tine: [0 -
right-hand image). Werking on Meibore o § selected

ENEERNERNENEEERNE
This details the activity during the P

. . . Ferforming Stepe  Menging diata from Permonal Folders bo Server
restore, including how many mailboxes

will be processed, and where ExMerge
is in the restore progress.

Cunrent Malboor Kbt Ginobles
Curenk Fioldar:

| conen | Heo |

Upon completion, the SMR Restore plug-in will then determine whether any errors were
detected and report this to the user.

If no errors were detected then =
the dialog on the right will be 7y Pstons complsted sccenshully,

h Py emors wesre debeched.

shown. For detals dhech kg libe s - Progras Flecyftind Baciup Prod i SE vy _earmerge g

[ o |
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If errors were detected, then the =l
dialog on the right will be shown. Biestirs complebed bt 2 erries were deterted,

For detals ched kg Nie ot O Pregram Fles|AltxS Beclug Profesmional SE s _gamengs.iog

[e]]

The indicated log file will detail the errors for further troubleshooting or problem solving.

ExMerge is a utility provided free by Microsoft & . Its initial intention was to alleviate the burden
of moving mailboxes between servers, and migrating mailboxes from, say, Exchange 2000 to
Exchange 2003. It primarily uses MAPI to accomplish all of this functionality and is a very
useful and configurable tool.

You wil | Efmemgeddocacn Wor d document pr ovplug-end Thigi t h t he
document provides some insight into the functionality ExMerge provides. In addition to

information about the various settings available for configuration with ExMerge, you should

read this document to understand what the various releases are, past and current bugs,

limitations of ExMerge etc. While we do not recommend that you manually change any of the
settings in the various configuration files, it
capabilities. Some important configuration settings to take note of:

MergeAction
;This setting controls which merge procedure to use:

: Possible values:

;0 - Extract (Merge data to Personal Folders)
;1- Import (Merge data from Personal Folders)
1 2- Extract&Import (Export from one server and Import into another server)

; Default value: O
SMR Backup: 0
SMR Restore: 1

SourceServerName
; Name of the source Exchangeserver, from which dat a will be extracted.

; This setting must be specified if the MergeAction specified is Extract or Extract&Import

SMRBackup only: set to whatever wuser specifies in

I'da)
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DestServerName
; Name of the dedination Exchange server, to which data will be written.
; This setting must be specified if the MergeAction specified is Import or Extract&lmport

SMR Restore only: set to whatevernamed seertifiebdin ¢

LogFileName

; Name of the log file to be used

; Default value: C: \ExMerge.log

SMR Backup: <PST Data Dir> \smrb_exmerge.log
SMR Restore: <SE Root Dir>  \smrr_exmerge.log

Log gingLevel

; Set the level of logging:
; Possible values:

; 0 - None

; 1- Minimum

; 2 - Medium

; 3 - Maximum

; Default value is O
SMR Backup and Restore: 2

DataDirectoryName

; Name of the directory to which .PST files w ill be written or where .PST files will be expected.

; If the directory does not exist, it will be created.

; Default value: C: \EXMERGEDATA

SMRBackup: set to value of OFolder to backup tob t ex
SMR Restor e: set to value of O6Folder to restore fr om¢

FileContainingListOfMailboxes

; Name of a text file containing the Exchange Distinguished Names (DN) of mailboxes to be;
worked on.

; Each line of the file should have the following format:

; <SourceDN> [, <TargetDN>]

; The TargetDN is optional. If it is specified, depending on what the selected merge action
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; is, it will be used to get the name of the PST file to be generated, or the name of the

; mailbox int o which data

; will be merged. By default, a comma is used as the delimiter between the source and

; target DNs. You

; can specify another delimiter, using the DelimiterUsedInMailboxFile setting.

; Blank lines are ignored.

; Lines beginning with a ##~ are ignored as comments

; If this setting is not specified, all mailboxes, except those for services (DS, IMS etc.) on the
; specified server will be processed.

; Default value: Blank

SMR Backup: <SE Root Dir>  \smrb_m ailboxes.txt
SMR Restore: <SE Root Dir>  \smrr_mailboxes.txt

DatalmportMethod

; This setting controls how the data will be copied from the source store to the target store.

; Possible values:

; 0 - Copy all messages from the source store to the target store

; 1 - Merge messages into the target store. Copy only those messages that do not exist in the
target store.

; 2 - Replace existing messages in the target store. (If a message in the source store

; exists in the taget store, delete that message in the target store and then copy the

; message from the target store.

; 3 - Archive existing messages from the source store into the target store. If this option
;  is selected, the program will copy data fro m the source store to the target store and
; then delete the data from the source store.

;This option is only valid if the MergeAction is Extract.

: Default value: 1

SMR Backup and Restore: 1
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The Attix5 SIR Exchange plug-in allows item -level backups to be done for Exchange 2007. This
includes mailbox folders, emails, mailbox local contacts, tasks, calendar items etc. Public folders
and documents are also supported.

To install the SIR plug-in on an existing SE Cient, run the Plug-in Installer,
Exchange 2007 Single Item Recover y plug-in in the list and complete the installation.

1/

The SE Client andplug-in must be installed locally on the Exchange Server.

select the

The SE Client service must be configured to run as a user that has Full acces to
the individual mailboxes that must be included for backup. Refer to the following
for further information:

Exchange 2007: Ensure that the server where the SIR plug-in will run ha s the

Mailbox role installed to match where the MAPI connection points are .

The SIR Plug -in node will be shown underneath the standard backup selection tree and forms

part of the existing backup selection. All configurations haveto be done within this view.

Start by clicking the main Exchange Items node in the tree.

[3] Attixs Pro SE ¥6.0.0 H=]
Fille Selection Tools Help
NSO
bakur s‘ze e Fm ool o ATTIX®Pro

' Backup Selection | o Bestore | (=] Logs |

2 My Computer
SR
RS
B
L
[
B
L
B
B
B
B
B
B
B
B
L
B
B
B
B

$Recydle.Bin

Boot

dientdump
Config.Msi

Develop

ex
ExchangeSetuplogs
exdump

inetpub

Perflogs

Program Files
Program Files (x36)
ProgramData
Pythonzé

rdo

Sun

System Yolume Information
Test

Users

- Windows

Exchange Single Item Plug-in - Backup Settings

Connection Details

DC Hast |HDJ—VM—E><CGDT.att\x5vm‘com

Mote: IF using the default domain controller, leave the 'DC Host’ field blank.

LDAP Part 3|I=

Access Mailbox |Administrator@attix5vm.com

Mote: The access mailbox owner must have access ta all maiboxes that need to be

backed up.

I~ Ignore absence of Public Folders

General

Dump Folder Path Iogram FileshAttixS ProtBackup Client SE\ExchangeSirDump Brawse

[~ Enable verbose Logaing

Apply

Last backup:23 Aug 2010 7:00:15 PM
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i) All settings that could be retrieved from the Exchange server will be pre -
populated and only dump location needs to be specified.

Ensure that the DC Host , LDAP Port and Access Mailbox fields are correctly populated and
specify a dump folder location. Verbose logging can be enabled by selecting theEnable
Verbose logging that will show more detail in the backup log files.

Click the Apply button before continuing. This will invoke a login onto the Exchange Server and
show all items that can be backed up according to the access granted to the user being used by
the Attix5 SE Client.

i) Any errors will be shown at the bottom beneath the Apply button:

| ENA0Ie ¥eroose Logging

Apply |

Error scanning For Exchange Servers: Invoke of: Execute Source: Provider Descripkion:
Permission denied.
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All selected items or nodes will be included with the next backup to be performed by the Backup

Client by using the dump folder as specified.

Before attempting to back up mailbox items, please ensure the following:
MS Exchange is installed on the local system.
Outlook is NOT installed on the local system.

For Exchange Microsoft Exchange Server MAPI Client and

Collaboration Data Objects 1.2.1 are installed on the local machine. These

can be downloaded from the Microsoft website at:

The login credentials for the primary access mailbox that is used to create a
MAPI session is correct and that this user has full access to the mailboxes

that you wish to back up items from.
The user that the service runs as owns the primary access mailbox.
The user is not hidden from Exchange address lists.

Exchange 2007: Ensure that the server where the SIR plug-in wil | run has

the Mailbox role installed to match where the MAPI connection points are .
Iltems that have not been changed since the last backup will not be exported to
the dump folder, as they do not need to be transmitted to the Storage Platform

again.

& Backup Selection | = &estorel B Logsl

o My Carmputer
FlL G

‘_ H:

5 Exchange Ihems
- Eb ik HDIMM-EXCGOT

: = Administrator@atkizSswem, com
= 5 Calendar

: 5 Subfolder

Contacks

-4 Subfolder

4 Subfolder

Meeting before the meeking
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For restores the required complete parent node or specific item must be selected for restore

i8 Backup Selection & Restore | =] Logsl

_ﬂ Backups iz
=i Last Backup (23 Jan 2010, 14:00:49) @ Meeting before the meeting
i [k Exchange Ttems

- HOIVM-EXCGOF

-
[=h [ Administrator@attizSvm.com

& Calendar

I Y- PR Py

i) Before attempting to restore mailbox items, please ensure the following:

MS Exchangeis installed on the local system.

Outlook is NOT installed on the local system.

For Exchange 2007 : Microsoft Exchange Server MAPI Client and
Collaboration Data Objects 1.2.1 are installed on the local machine. These can be
downloaded from the Microsoft website at:

The login credentials for the primary access mailbox that is used to create a
MAPI session is correct and that this user has full access to the mailboxes that
you wish to back up items from.

The user that the service runs as owns the primary access mailbox.

The user is not hidden from Exchange address lists.

Exchange 2007: Ensure that the server where the SIR plug-in will run ha s the
Mailbox role installed to match where the MAPI connection points are.

Click the Restore button on the toolbar. In the
S Restore Options  dialog box, select the
R Exchange Plug -in: SIR tab. Verify the required
pe fost LHE:VITLT:;S;Z:Ziﬁm.fmfmmmue,,mmmm« settings for the Domain Controller Host ,
o ez LDAP Port , Access Mailbox and Temporary
R e S Path location that will be used as part of the

mailboxes that need to be backed up.

restore process.

I~ 1gnore absence of Public Folders

i) If experiencing problems connecting
to an Exchange 2007 server that has no

Platform can be dumped. H

Temporaty Path xS ProjBackup Client SE\ExchangeSirDump Browse pUbIIC fplders’ SeIeCt the |gn0re absence

A — of Public Folders  check box.

General

This i the location where Exchange related files obtained from the Storage

The items selected for restore will be recovered
ok | el | ek directly to the live Exchange Server.
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The Attix5 Pro Exchange SIR Plus plug-in allows mailbox or item-level restores to be done for
Exchange 2010SP1 (build 218.15) or later This includes mailbox folders, emails, local contacts,
tasks and calendar items. The Exchange SIRPlus plug-in does not replace the Exchange Single

Item Recovery plug-in and is not backwards compatible with it.

& | Example:  To restore an individual email from a mailbox an administrator would use

the Exchange SIRPIus plug-in to back up the mailbox. When restoring, he would then be

able to navigate to and restore an individual emai |instead of having to restore the

entire mailbox .

Installation

To install the Exchange SIR Plus plug-in on an existing SE Client, run the Plug-in Installer,
select the Exchange 2010 Single Item Recovery Plus plug-in and complete the

installation .

i) | Not es:
oV

The plug-in requires version 6.2 of the SE Client and Plug-in Installer.
The SE Clientand plug-in must be installed locally on the Exchange server.

When installing the plug -in on an Exchange server farm, the Backup Client and

plug-in must be installed on a Client Access Server (CAS) role.

Outlook must not be installed on the Exchange server.

To restore directly to Exchange, Microsoft Exchange server MAPI Client and

Collaboration Data Objects 1.2.1 needs to be installed.

The plug-in also requires the Microsoft .NET Framework 3.5 to be installed.

¥® Plug-in Installer [ X] |

Select the plugins you want installed.

Plug-ins marked with a* are already installed on the spstem.

Plug-ins marked with a* will be upgraded.

W & Email Notification
[]  Exchange 2003 Single Mailbox Recovery
[]  Exchange 2007 Single ltem Recovery

Exchange 2010 Single Item Recovery Plus

i) | Note: The plug-in needs to be licensed to function.

! Admin[ Notiﬁcaﬁonl Expiry I Roll-upsl Messages l Updates I Proﬁling‘ Licences |

Select any combination of licence types from the list below and then assign an amc
licences using the add and remove buttons. Press OK to save your changes.

Licence 4 Total ¢ Assigned 4 Remaining

Server Edition 100 5 95

Exchange Single Item Recovery Plus 100
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The Exchange SIRPlus plug-in can be configured from the Plug-in Configuration page of the
Account Setup Wizard.

I! Account Setup Wizard B3

Plug-in Configuration

The Following plug-ins can be configured now, or yvou can configure them later via the Tools ¢ b @
| Plug-ins menu option.

i~ Configurable Plug-ins -

Email Motification v2.13
Exchange Single Item Recovery Plus

Configure... |

To configure the Exchange SIR Plus plug -in:
1. SelectExchange Single Iltem Recovery Pluson the

Account Séntup Wizar
Configuration page and clickthe Co n f i g wbuttené

[B)Exchange Single Item Recovery Settings

[~ Run the Exchange Agent on: -

Host: llocalhost

Port: 18011

i~ Exchange Agent Run-as credentials: -

Domain: |QA

Username: |administrator

Password: I**********

[~ Temporary Folders (for backup processing) -

Dumnp mailbox data to: lC:lProgramData'l,RttixS ProiClientiSIRiMailboxes Browse I

Extract mailbox items to: IC:\ProgramDatamttixs ProiClient}SIR\msqg Browse

i~ Rights —
v Automatically assign required roles to the Exchange run-as user

[V Automatically assign mailbox permissions as needed on backup start @ This may take up to 15 minutes.

OK Cancel Apply
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2. Ensure that the Host and Port boxes are correct.

i The Host should always be set tolocalhost

P

3. Enter the Domain , Username and Password details. These boxes specify the
Domain user credentials that the Exchange Agent runs as.

i The Exchange Agent must run as a Domain user that has been granted
full permission to the mailbox(es) . This will be done automatically by the Backup
Client, unless the user deselects the Automatically assign mailbox
permissions ¢é check box.

4. Ensure that the Dump mailbox data to and Extract mailbox items to boxes are
correct. These boxes specify the temporary veorking folders for the Exchange SIR Plus
plug-in and are used during the backup and restore processes.

5. Select the Automatically assign required roles € check box if you want the
Exchange Agent to automatically give its run-as user the necessary Import/Export roles
in Exchange. These roles are needed in order to perform a successful backup. If this is
check box is not selected, the roles will need to be manually assigned to the rupas user
from the Exchange Management Shell or the Exchange Management Console.

6. SelecttheAut omati cally assign ma icHedk box if yoe wamtitss si ons é
automatically assign full access permissions for the Exchange Agent runas user to the
selected mailboxes when a backup starts.Assigning mailbox rights could take up to 15
minu tes to take effect depending on Active Directory replication.

The Plug -ins > Exchange SIR  Plus > Assign mailbox  rights menu

item can be used to assign selected mailboxes the required rights. Alternatively,
the administrator can use the Exchange Mana gement Shell to manually assign

/
=

rights.
7. Click the Apply or OK button to change the Exchange SIRPlusplug-i n6s settings. I f
have selectedtheAut omat i cal | y as s i g ncheckbgxithemplagdinwilo!| e s é

automatically assign the needed Exchange roks to the Exchange Agentun-as user.

i Any errors will be shown above the Run the Exchange Agent on
section and next to the field where the error occurs.

E Exchange Single Item Recovery Settings

*. Please fill in all Fields, and then click. Apply again.

Run the Exchange Agent on:

Huosk: I localhiost

Part: I 1(3 Flease type the port number,
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i Clicking the Apply or OK buttons causes the plug-in to run a series of
checks to ensire that it is working correctly. These checks include:
The connection between the Backup Client and the Exchange Agent
The run-as user credentials
Whet her the Exchange Agent is instzé:
The Exchange version
The MAPI version and connection points
Whether Outlook is installed or not
Whether Microsoft .NET Framework 3.5 is installed. The Exchange Agent
will not work with  only Microsoft .NET Framework 4.0 installed .

[§] Task Progress Ed

esting connection. .. .

osthame @ QAExchz010 —
gentversion ;

gentRunfslser

wrchangeYearVersion @ 2010

wrchangeEdition ; StandardEwaluation
wrhangesdminDisplayiersion ; Version 14,1 (Build 215, 15)
wchangeRoles ; Mailbox, ClientAccess, HubTransport

kmn : False

omain 0, local

eceivePaort @ 5012

eceivelocation : C:\ProgramDatalattixs ProlASEARecei
wrchangeDataPath ¢ CProgram FilesiMicrasaftiExchange ¢
wrhangelistinguishedMame | CH=0AEXCHZ010,CN=S&f"vs

The Task Progress dialog box contains a lot of detailed information. You can right -
click the dialog box and copy the contents to the clipboard if needed for support
purposes.

The plug-i n6s configuration has now been wupdated,
installed. The Exchange SIRPIlus plug-in node is displayed in the standard backup selection tree
and forms part of the existing backup selection.

i If you chose not to configure the plug -in in the Account Setup Wizard, you
“ | are asked to configure it when you select the Exchange Mailboxes node. Clicking
the Configure Now  button brings up the Exchange Single Iltem Recovery Plug -
in Settings dialog box.

Exchange Single Ikem Recovery Plug-in

The Exchange Single Ikem Recovery plug-in has nok been configured,

Configure Maw

and
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After the Exchange SIR Plus plug-in has been configured, selecting the Exchange Mailboxes
node displays the current Exchange server detdls and allows you to change the configuration.

i@ Backup Selection | = | EES'I'rel B I;Dgsl

L:_HJ_. el

using the Tools > Plug

B
E-
-4
..L_'_
..L_'_
L
-2
-
..L_'_
#-| ~ Recavery

_ System Volume InFormation

~Windows

& My Computer

$Recycle. Bin
31467110bb0bS168FRdE
attixs

data

Logs

PerfLogs

Program Files

Program Files {x86)
ProgramData

Users

Exchange Single Ikem Recovery Plug-in

Connected ko Exchange server:

— Exchange Server Details:

Hosk Mame: QAExchz2010

Cramain: 04 local

Yersion:

Roles: Mailbo:x, ClientAccess, HubTranspaork

Agenk run-as user:
Agent version:

Zhange configuration

The Exchange Single Item Recovery Plug-in Settings dialog box can also be opened

-ins > Exchange SIR  Plus > Settings menu item.
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Exchange SIR Plus menu :

When the Exchange SIRPlus plug-in is installed its menu is added to the menu bar under the

Plug-ins item.

Options

Exchange SIR Flus b Assign mailbox rights

Agent Reinstal
Agent Uninstall

Test Conneckion

Settings

The table below provides a description of the options available in the Exchange SIRPlus menu.

Tools > Plug -ins > Exchange SIR  Plus

Assign mailbox
rights

Agent Reinstall

Agent Uninstall

Test Connection

Settings

Automatically assigns full access permissions for the Exchange Agent runas user
to the selected mailboxes when a backup starts.

Automatically uninstalls, reinstalls and starts the Exchange Agent with the

Note: Assigning mailbox rights could take up to 15 minutes to take
effect depending on Active Directory replication.

credentials that you specify in the domain, username and password boxes.
Automatically uninstalls the Exc hange Agent.

Tests the connection between the Backup Client and the Exchange Agent. If the
Backup Client cannot connect to the Exchange Agent, it provides an error
detailing why.

Opens the Exchange Single Item Recovery Plugn Settings dialog box that
enables the configuration of the plug-in.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.



ATTIX’

All selected mailboxes will be included with the next backup performed by the Backup Client
using the temporary folders as specified. Selecting a mailbox diplays the mailbox details,
including the alias, display name, and GUID among others. The plug-in will back up the entire

mailbox.

& Backup Selection | = | BEStC'rel E| LI:II;S'

o My Computer

_ C:

= G Exchange Mailboxes
O - rinistr ator

F DiscoverySearch

3 ]

N
~

Exchange Single Item Recovery Plug-in

Mailbiox: Details:

Alizs:

Display Mame:

GUIC:

Primary SMTP Address:
Sam Account Name:
Izer Principal Mame:

when backing up Exchange items.

Adminiskrator
Administrator

0d451 393-9877-4FFF-399b-0701 56 752c59

Adrminiskrator

Bdminiskrator@oa. local

The same checks that take place when configuring the plug-in occur

Preparing backup

The backup progress dialog box contains a lot of detailed information. You can
right -click the dialog box and copy the contents to the clipboard if needed for support

purposes.

Connecting ko Storage Platform on gahiveas: 443
Server name: Hive, AttixS Dey Qf, St
Initializing secure random generator,,
Connecting ko Storage Platform on gahiveas: 443
Server name: Hive, 8ktixS Dev QA, Stellenbosch
[Exchange SIR Plus Plug-in] Skarting. ..
[Exchange SIR Plus Plug-in] Extract Folder: C:\ProgramDatalatti=S ProfClie
[Exchanage SIR Plus Plug-in] Mailbas: dump Falder: Ci\ProgramD akalakkixs P
[Exchange SIR Plus Plug-in] Exchange fAgent address: localhost: 3011
[Exchange SIR Plus Plug-in] Testing Agent conneckion, ..
[Exchange SIR Plus Plug-in] Detected Agent version; 10,4294, 29255
[Exchanage SIR Plus Plug-in] Detected Agent "Run-as" user: SC1HY adminiskr
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3 Backup Selectinnl o Restare (=) Logs

0% Ock 2011, 19:00:00
05 Ock 2011, 15:41:57
05 Ock 2011, 15:41:09
05 Ock 2011, 153720
05 Ock 2011, 15:35:08
05 Ock 2011, 15:21:30
05 Ock 2011, 1501706
05 Ock 2011, 14:45:05
05 Ock 2011, 14:43:36
05 Ock 2011, 1443122
05 Ock 2011, 14:43:06

E5530E]
e55a0e:
E5530E]
e55a0e:
E5530E]
e55a0e:
E5530E]
e55a0e:
E5530E]
e55a0e:
E5530E]
e55a0e:
E5530E)

15:58:38 [Exchange SIR Plus Plug-in] Starting. .. -
15:53: 33 [Exchange 3IR Plus Plug-in] Extract Folder: CriProgramDatataktixs ProfClientt SIRmse
15:58:38 [Exchange SIR Plus Plug-in] Mailbox dump Falder: C:\ProgramDatalattixs ProtClient!,s]
15:53: 33 [Exchange 3IR Plus Plug-in] Exchange Agent address: localhost 011

15:58:38 [Exchange SIR Plus Flug-in] Testing Agent connection, .,

15:53: 39 [Exchange 3IR Plus Plug-in] Detected Agenk wersion: 1.0,4294, 29253

15:58:39 [Exchange SIR Plus Plug-in] Detected Agent "Run-as" user: SC1H\administrator
15:55: 39 [Exchange IR Plus Plug-in] Backup done for Exchange Server SCIHCAS

15:58:39 [Exchange SIR Plus Plug-in] Detected Exchange 2010 StandardEvaluation 14,.01,0218
15:53: 39 [Exchange IR Plus Plug-in] Werifving/Assigning required mailbox permissions. ..
15:58:43 Profiling exclusions: n/a

15:53:43 Profiling exclusion date: nja

15:58:43 Profiling inclusions: nfa

i) The backup log contain s a lot of detailed information that could be useful

for support purposes .
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The Exchange SIRPIlus plug-in allows mailbox or item-level restores to be done for Exchange
2010 SP1 (build 218.15)or later. This includes mailbox folders, emails, local contacts, tasksand
calendar items. Normal files and Exchange items cannot be restored in a single restore and
attempting to do so results in an error message. Separate restores have to be performed for the
normal files and Exchange items.

ALLix5 Pro SE | x|

'0' You cannok restore Exchange mailbosx items and other items at the same kime,
k Please alcer wour selection and, if necessary, perform bwo separate restores,

e

If you want to restore mailbox data, ensure that Microsoft Exchange server MAPI
Client and Collaboration Data Objects 1.2.1 is installed on the local machine. This
can be downloaded from the Microsoft website at:

Ensure that Outlook is not installed as this will cause the res tore to fail.

To restore Exchange items to a folder structure or a ZIP file
1. Navigate to the Exchange Iltems node in the Restore tree.

= Backup Selection & Restore | =] Ln:ngsl

ol Backups
|_——_|1|_ Last Backup (12 Sep 2011, 16:05:55)
SN change Trems
5 e Administrator

L SPAM Search Folder 2

-

- g Search Foot

i L& Top of Personal Folders
e g Workspace
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2. Select the items that you want to restore, and then click Restore on the File menu or
the Restore button on the main toolbar. This will launch the Exchange Plug -in: SIR
Plus dialog box.

[5] Exchange Plug-in: SIR Plus

Reskore Locakion

% Local folder: IC:'I,PrngramData'l,AttixS ProiClientiSIR\Restore Browse |

{~ Exchange server

Restore Format

Save files as; Folders and .M50G files j

N . Folders and MG files
Additional options —{zgp fone per mailboz) |

[~ Cwerwrite mailbox items

[~ Maintain directory struckure

ik, Cancel Help

3. Ensure that the Local folder path is correct. The Exchange items will be restored here.

i Ensure that this folder has sufficient space to hold the items being
restored.

4. Select the format that the Exchange items should be restored as. You can choose either
Folders and .MSG files  or ZIP (one per mailbox)

5. Select the Maintain directory structure check box to maintain the directory
structure instead of restoring all items to the root folder.

6. Click OK to begin the restore.

The restore progress dialog box contains a lot of detailed information. You can
right -click the dialog box and copy the contents to the clipboard if needed for support
purposes.

The Exchange items arerestored to the location specified in the Local folder box in the chosen
format.

i The restore log contains a lot of detailed information that could be useful
for support purposes .
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To restore Exchange items directly back into an Exchange server
1. Navigate to the Exchange Items node in the Restore tree.

& Backup Selection & Restore I g L'I";IS|

ol Backups

EH_ Lask Backup (12 Sep 2011, 16:03:55)
E} Wl change Ikems

PoE- i Adrninistrator

G SPAM Search Folder 2

o Search oot

_ # |5 Top of Personal Folders

“ ik workspace

2. Select the items that you want to restore, and then click Restore on the File menu or
the Restore button on the main toolbar. This will launch the Exchange Plug -in: SIR
Plus dialog box.

3. Select theExchange server option.

i Selecting the Exchange server option initiates a series of Exchange
configuration checks, including:

The connection to the Exchange Agent and the IP address of the Exchange
server that it runs on

The Exchange version (Exchange 2010 SP1 [build 218.15]or later is
required)

The MAPI version

Whether Outlook is installed or not (the restore will fail if Outlook is

installed)
E Exchange Plug-in: SIR Plus [ x|
Restare Location
" Local Falder: IC:'l,PngramData'l,AttixS Prol ClientSIR\Restore Browse

Temporary restore Location: IC:'l,ProgramData'l,AttixS Prof ClienthSIRRe Browse |

Exchange configuration checks

@ Exchange running on: localhost Change settings
@ Exchange version supported: 14,1 (Build 218.15)
@ MAPT ¥6.5.8211.0 installed

Additional options

Please confirm restore settings:

Maintain directory struckure: Ves Change
Recreate missing mailboxes: Ves Change
Automatically assign mailbosx rights: es Change

Gk, Cancel Help
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4. Ensure that the Temporary restore location path is correct. The plug-in will store
the Exchange items in this folder until it can transfer them to the Exchange server.
5. Click Change settings to launch the Exchange Single Item Recovery Settings dialog
box if you want to change the Exchange SIRPIlus settings.
6. Review the additional options and click Change to change the relevant setting:
1 Maintain directory structure maintains the directory structure instead of
restoring all items to the root folder .
1 Recreate missing mailboxes recreates any mailboxes that no longer exist.
v | Warning:  The mailboxes are recreated with P@ssword0123! as the default

password. The administrator needs to reset the password and configure any
other user-associated settings.

1 Automatically assign mailbox rights automatically assigns the correct
mailbox rights to the Exchange Agent.

7. Click OK to begin the restore.

The restore progress dialog box contains a lot of detailed information. You can
right -click the dialog box and copy the contents to the clipboard if needed for support
purposes.

The Exchange items are restored directly into the Exchange server.

i) The restore log contains a lot of detailed information that could be useful
for support purposes .
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Should you encounter any errors when using the Exchange SIRPIlus plug-in, check this section
for possible solutions.

Issue :
When backing up Exchange items using the Exchange SIRPlus plug-in, the following error
occurs.

Message: 11:57:43 [Exchange SIR EE Plug-in] Dumping and indexing Mailbox Allison Best
® Error: 11:58:07 [Exchange SIR EE Plug-in] Error in call with Exchange Agent, Couldn't connect to the source mailbox..
Message: 11:58:07 [Exchange SIR EE Plug-in] Dumping and indexing Mailbox Anita Bird

Error: 11:58:08 [Exchange SIR EE Plug-in] Error in call with Exchange Agent, Couldn't connect to the source mailbox..

Solution:
The Microsoft Exchange RPC Client Access service is not running. Navigate to the Services
Management Console and asure that the service has been started.

* *Microsoft Exchange RPC Client Access Manages dientRPC c... Started Network S
& Microsoft Exchange Service Host Provides a host for s...  Started Automatic Local Syste

Automatic

Issue :
When backing up Exchange items using the Exchange SIRPlus plug-in, the following error
occurs.

[Exchangle SIR EE P|LIEI -in] Error in call with Ech;ange Agent, There are no available servers running the Microsoft Exchange Mailbox Replication service..
Total selection: 443 bytes in 3 files and folders

Solution:
The Net.TCp Port Sharing ok Microsof't Exchange MaiIIIJDx_REpIicaﬁon Processes ... Automatic
" Microsoft Exchange Monitoring Allows appl... Marual
Service and Microsoft Exchange " Microsoft Exchange POP3 Provides P... Manual
: : ; : “ChMicrosoft Exchange Protected Service Host  Providesa ...  Started Automatic
Mailbox Repllcatlon services are “C:Microsoft Exchange RPC Client Access Manages d... Started Automatic
not run ning. Navigate to the ‘£ Microsoft Exchange Service Host Providesa ... Started Automatic
. 15 Microsoft Exchange Transport The Micros...  Started Automatic
Services Management Console and “Ck:Microsoft Exchange Transport Log Search  Providesre... Started Automatic
ensure that the services have been "L Microsoft Fibre Channel Platform Registra... Registers t... Manual
-5 Microsoft iSCSI Initiator Service Manages L... Marual
started. “ChMicrosoft Search (Exchange) Quickly cre... Marual
‘L Microsoft Software Shadow Copy Provider  Manages s... Manual
“ChMultimedia Class Scheduler Enables rel... Manual
‘£ Net.Msmq Listener Adapter Receives a... Disabled
‘. Net.Pipe Listener Adapter Receives a... Started Automatic
“CFNet.Tep Listener Adapter Receives a... Automatic

* 4 Net. Tcp Port Sharing Si Provides a... Automatic
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Issue :
When changing the SIRPlusplugi nés configuration, the following er

[5] Task Progress

Ininskalling the AtkixS Exchange Agent

@ Installing AkkixS Exchange Agent
Starking AtkixS Exchange Agent

Error: jawa.net, SocketTimeoutException: Read timed out

Solution:
The user does not have the correct permissions. Addthe user to the Domain Admins group to
solve the problem.

Issue :
Uninstalling the SE Backup Client does not uninstall the Exchange Agent.

Solution:
The user should ensure that he first uninstalls the plug-in using the Plug-in Installer before
uninstallin g the Backup Client. If he has already uninstalled the Backup Client, he can manually
uninstall the Exchange Agent by following these steps:

1. Open the Command Prompt with Administrator privileges.

2. Navigate to the folder that the Exchange Agent was installedin.

3. Runthe ASEAS.exe T uninstall command to uninstall the Exchange Agent.

- Administrator; C\Windows\system32\cmd.exe

g service A .
stopping the : L.

jy File For the C:xProgram Files“wAttixbt Proexchange—ag
SOYPEES .

“Program Files“Attixh Proexchange—agent~ASEAS.Installls

i Progran Files“Attix5 Prosexchange-agent~ASEAS .exe’ .
are:
= Attix% Exchange Agent

rogram FilessAttixh Pro je—agent A5
Filez“Attix5S Pro“exc ] ant~ASEARS .

1] E
ice ASER
vice ASEA was

The uninztall hasz completed.
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Integrate the critical data protection of Lotus Domino messaging and collaboration databases

within daily backup activities.

Using the native Domino backup API, this option integrates non -

disruptive data protection of the database and transaction logs. Flexible restore options include
database redirection and point-in-time roll back recovery of databases or transaction logs.
Lotus Domino plug-in for version 6.5/7 also gives administrators the flexibility to perform
individual mailbox backup with selective restores of individual messages.

i Attix5 Pro SE with the Lotus Domino plug-in should be installed on a Lotus
Domino server as it automatically configures the communications between the two
applications. The Domino services must be running in order for the plug-in to access the

files selected for backup.

To upgrade SEwith the Lotus Domino plug-in, run the Plug-in Installer and select the Lotus
Domino 6/7 plug-in. After the installation, open the Attix5 Pro SE Client.

[ Attix5 Pro SE ¥6.0.0

=10l x]
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Database dump Falder

|C:'|,Pr0gram FilesiAttixS ProlBackup Client SE\Domino

Save | Erowse. ..

Ready | Last backup:22 Jan 2010 1:21:04 AM

click the folder name in the left-hand pane and Include
selected in the right-hand pane. If you Include

the selection.

If you are familiar with
the SE Client interface,
you will notice that there

are two new tabs,
Domino  Backup and
Domino Restore

Open the Domino
Backup tab. The SE
Client displays the
Domino Server in the left-
hand pane.

The Domino  Back up

tab enables you to select
the components that you
wish to backup. To select
the Domino Server or any
of its subfolders, right-
Individual files can be

the Domino Server , you will automatically

back up the entire Domino Server as well as any new files added to the server in future.
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Select the location for the Database dump folder beneath the selection window. The default
path is C:\Program Files\Attix5 Pro\Backup Client SEEADomino. A copy of the selected
components from the Domino server is created in this folder should you wish to change this
location, use the Browse button. From here, the files will be encrypted and backed up.

The SE Client requires working space for the cache(which is compressed), a temporary copy of
each database (the dump folder) and temporary disk space for creating patches to be sent to the
Storage Platform.

Make sure that your computer has enough free hard drive space to store a data
dump of all the selected databases.

Note that you have to click the Save button after you have made your selection .
The SE Client will no t backup the selected components if you do not

save the selection

Your Domino Server Backup selection is now configured.

The Backup Process : To create your first backup, selectBackup Now on the File menu.
Attix5 Pro will create an exact copy of the selected components in the dump folder. These files
will be compressed and transferred to the Storage Platform. Subsequent backups will be
compared with the selection from the previous backup. Attix5 Pro will create a patch file for
each database or mailbox with all the changes made since the last backup. Only the patch files
and any new selections will be backed up.

Open the SE Clientand click on the Domino Restore tab.

You first have to retrieve the dump folder from the Storage Platform before you can restore the
Domino Server. Click the @ Restore tab, select the dump folder from the specific backup date
and restore the folder to its original location

On the Domino Restore tab, use the Browse button to select the Recovery folder that you
restored from the Storage Platform. The default path is CAProgram Files\Attix5 Pro
SE\Domino. The Domino Restore tab displays all files available from the specific backup. Note
that you have to browse and select theRecovery folder  before you will be able to view the
data. You can browse through the available fdders to select the specific mailboxes and files, or
you can select the top node to restore all available files.

A Full Media Restore is initiated by enabling the check mark next to Full Media Recovery
This option selects the entire backup set, including the necessary configuration files (ini file, cert
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ID and server ID) to do a full media restore. The procedure when you have to do a Full Media

Recovery:

1.

a bk~ wDN

After you have selected the files that you want to restore and click onRestore .

v

Install the Domino Server

Run the Domino setup, but DO NOT START THE EERVER
Restore the recovery folder

Do a Full Media Recovery

Start the Domino Server

The selected databases or mailboxes should be closed during the rstore process.

The SE Clientwill restore the selected files to the Domino Server and the SE Client will notify
you when the restore has been completed. You are advised to initiate a full backup after
recovering a large amount of data.
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The Attix5 Exchange Server plug-ins enable fast and flexible waysto protect vital Exchange
2003/2007 critical data while the applications are online. Using the Exchange APIs to
communicate with the Exchange server, the plug-ins provide backup and restore capabilities for
all Exchange Server components, including embedded files.

i) MS Exchange Server 2010 is not supported using this plug -in. Use the VSS plugin

for M S Exchange Server 2010.

N

The SE Client with the MS Exchange plug-in must be installed on an existing

Exchange Server as it automatically detects and configures the communications

between the two applications. The Exchange Server services must be running for the
plug-in to access the files selected for backup. If you wish to install the SE Client on a
different machine , you need tofirst install Exchange on that second machine to pro vide
the libraries required by the Exchange plug -in.

If you are installing the Single Mailbox Recovery (SMR) plug-in as well, please do so
before installing the Exchange plug-in to ensure that the SMR mail profile is configured

correctly.

Server Edition can be upgraded with the Exchangeplug-in by running the Plug -in Installer and
then selecting the MS Exchange Server 2003 /2007 plug-in. After the upgrade, open the
Client to configure the plug-in. On the Tools menu, selectPlug -ins , and then click Exchange

2003 /2007 Backup settings

[3) Exchange backup settings i

Storage folder backup selection

Storage dump Folder |kup Professional SE\MSExchBackup

G} Servers
B QAZK3SERVERSTD
B Microsoft Exchange Server
v First Storage Group
[} Second Storage Group
v Third Storage Group

Ok Cancel

Browse

x|

Select where you would like the SE Client to
create aStorage dump folder . This folder
is used to dump a copy of the selected
storage groups from the Exchange server.
From here, the files will be encrypted and
backed up. The default dump folder is
C:\Program Files \Attix5 Pro
SE\MSExchBackup

i Ensure that your computer has
| enough free hard drive space to store
a dump of all the selected storage
groups.
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The SE Client requires working space for the cache (which is compressed), a temporary copy of
each Exchange storage group (the dump folder) and temporary disk space for creating patches
to be sent to the Storage Platform

The next step is to select the storage group(s) that you would like to backup. You have the
option to select individual storage groups by expanding Servers and selecting the Storage
Groups one by one. If youseled the Servers box, you will automatically back up all the storage
groups within the Server.

You have the option to choose between Full or Incremental backups. Rightclick on a Storage
Group and select Properties to specify your preferences. The following window will be
displayed:

From here you can modify the x4
Daily Backup Type for the Daily Backup Type
selected storage group. TheSE Only dofull backaps () Apply this selection to o storage groups

Sunday Monday Tuesdyy  Wednesday Thursday  Friday Saturday

Client will, by default, do full

backups during each backup. 9 y

Incremental @ . - . . .

v Conxed

%

To enable incremental backups (only the Exchange log files), deselect the Only do full
backups box, and then specify the dayson which to do incremental backups.

i At least one full backup per week will still be enforced if you enable incremental
backups.
Select the Apply this selection to all storage groups check box if you wish to use the same

configuration for all selected storage groups. Click OK to save the changesor Cancel to go back
to the Exchange backup settings dialog box.

Click Ok to save the settings. Your ExchangeServer Backup is now configured.

The Backup Process : To create your first backup, selectBackup Now on the File menu.

Attix5 Pro will create an exact copy of the selected storage groupsn the dump folder. These

files will be compressed and transferred to the Storage Platform. Subsequent backups will

compare the selected storage groups with the selection from the previous backup, which is
stored in a cache Attix5 Pro will create a patch file for each storage group with all the changes
made to the storage group since the last backup. Only the patch files and any new selections will
be backed up.
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Attixs Pro provides you with two options when backing up Exchange 2003/2007 ; Full and
Incremental Backups.

The Full Backup process is straightforward. All databases are backed up, and the log files for
the particular storage group are removed after the data has been incorporated into the databases
using a process called truncation. Using the efficient patching techniques available in Attix5
Pro, only a small percentage of the full backup is transferred to the Storage Platformon a daily
basis.

During Incremental Backups , only the storage group changes sine the most recent full
backup are protected. These changes are stored in the Exchangéog files and truncated into the
storage group during the next full backup. Note that when restoring you need the most recent
full backup as well as all the incremental backups between the last full and the required recovery
point (RPO). Attix5 Pro will automatically restore all the required files dur ing the restore
process.

It is very important to follow the se steps:

1. Ensure that Exchangehasthe same service pack level as when the data was backed up.

2. Set the database to le overwritten by a restore. Use the Exchange Management Shell to
view the properties of the database that you will be restoring. Select the This database
can be overwritten by a restore check box to ensure that the database can be
restored.

/Yy | Warning:  Not selecting this option will cause the restore to fail .

3. Delete or move all the .log files in the MDBDATA folder in the Exchange installation
directory. If these files are locked, stop the Exchange Information Store service and try
again. Start the service and if there are any logs created (after starting the service) delete
or move them as well. A restore can now beperformed as usual.

4. Open the SE Client, select Plug -ins on the Tools menu, and then click Exchan ge
2003 /2007 Restore wizard . The Exchange Restore Wizard enables you to restore
any Exchange Storage group without having to restore the backup from the Storage
Platform first, as the Exchange Wizard will automatically restore the files from the
Storage Platform, should you choose to restore from a previous backup.Follow the steps
as outlined below.
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Restore Wizard Step 1

In the first step, select either Restore from lo cally available backup or Restore from
previous backups . Click Next to continue.

Restore Wizard Step 2

If you select the first option, the SE Client will use the last backup that is stored locally on the
server. If you select the Restore from previous backups option, the SE Client will connect
to the Storage Platform and display a list of available Exchangebackups.

The Storage Groups availablein the backup that you selected are displayed in the second step.
Select whether youwish to Dismount the stores  before recovering the groups.

i Deselect this option if you are restoring to a Recovery Storage Group .

/4

Specify whether you want to Restore all Storage Groups or Specify restore options for
each Storage Group . Click Next to continue.

Restore Wizard Step 3

In the third step, specify the Exchange Server and Storage Group towhich you wish to restore
the data. The original Exchange Server and StorageGroup information is displayed by default.
Also specify the following by enabling/disabling the checkboxes:

Mount databases after restore - If you deselect this option, you will have to
manually mount the Store after restoring it.

Wait for Exchange  to complete restore - the SE Client will wait for confirmation
from MS Exchange before it notifies you of the successfulRestore.

Only restore log files T Use this option to only restore the log files.

Click Next to continue.

The last step dispays a summary of what you have configured. You can change the temporary
path that the SE Client will use for the log and patch files by clicking the Browse button. Click
Start restore  to start the restore process. You have to select a backup set that yowould like to
Restore from . Click Browse , and then select the storage group that youwish to restore. The
Client will list all the details from the backup 71 displaying the Backup date, to which server the
backup should be restored and the selected Storag group.

If Exchange cannot mount the store, run the Exchange fieseutildapplication and try again.
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You can do this either by using the Microsoft Exchange Troubleshooting Assistant (EXTRA) tool,
or by running the New-StorageGroup cmdlet with the i Recovery parameterin the Exchange
Management Shell. In this FAQ, EXTRA is used.

To create the RSG using ExTRA, launch the tool by opening the Database Recovery Tool(This
is found under the Toolbox work center in the navigation tree of the Exchange Management
Console (EMC). The tool will first want to check for any tool or configuration file updates that
may be available. After this, click on the Go to Welcome screen  link. Enter a label for this
activity (such as fiCreate RS@), and then click Next . On the appearing Tasks list, click Create
a Recovery Storage Gr oup, and then select the Storage Group youwish to link with the
RSG. For example, if your Storage Group is called fiFirst Storage Groupd ,you will select
that. Click Next once again.

You now need to provide a name for your RSG. The default name should be fine, namely
Recovery Storage Group. After this is done, click Create the RSG . After a while, you will be
notified that the RSG for the respective Mailbox Database has now been created.With the RSG
created, we can how move, copy or restore db and tensaction log files to the RSG paths. To see
the path for the recovery storage group log and database files, clickShow Create Recovery

Storage Group Information . The default is CA\Program Files\ Microsoft\ Exchange
Serven Mailbox \ <Storage Group>\ RSGxxxxxxxxx. DO NOT TRY AND MOUNT THE RSG YET.

Go to the Restore tab in the Attix5 SE client. Click on the date that you require the data from.
As soon as you haveclosed the date, you will have the option to expand and all the data backed
up will appear. Click on the VSSwriter section to the bottom of the selected date. One of the
options will be called Exchange writer . Expand this until you get to the databases. The
databases will have their GUID names, so you will have to go into the folder to identify the
database. Select the specific Mailbox Database youwish to restore, as well as the checkpoint
files and logs. DO NOT SELECT THE EXCHANGE WRITER IN ITS ENTIRETY FOR
RESTORE, AS THIS WILL OVERWRITE THE LIVE DATA!

Restore these files to an alternative location, for example D\ Restore. Now copy the restored
files to the Recovery Storage Group location as created in the previous part.
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Go to the EXTRA Task Center. Under Manage Databases , Click Verify Database and
transaction Log Files . This is to verify that the database is in a clean shutdown state. As
soon as this is complete, you can mountthe RSG by clicking onMount or Dismount databases in
the Recovery Storage Group. This is under the Manage Recovery Storage Group heading. On
the next screen you can mount the database. When the Mailbox Database has been mounted,
click Go back to task center , and then select Merge or copy mailbox content . The next
screen will show us the mailbox database, and there will be a button for Gather merge
information

On the Select Merge Options page we must click orPerform pre -merge tasks . The final step
would be to select the mailboxes youwish to merge. You will have a list of users on the mailbox
database, click on the ones you want to merge. After doing this, wait for the tool to merge the
mailbox data from the RSG Mailbox Database to the selected mabox.

When you have merged or copied the required Mailbox data, you can use EXTRA to dismount
and then remove the Recovery Storage Group. Be sure you remove the files in the RSGXXXXXXXXX
folder again after you have akeapwaualdediskspace so t hat t he
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The Attix5 MS SQL plug-in provides SQL Server 2000/200 5/ 2008 (including R2) protection
down to the individual table or file group. Execute binary patching backups as well as
Transaction Log backups with automatic truncation. Restore options include redirection to
another SQL Server using the native SQL restore pro
restoreso, enabling a databaspgobt o be recovered to a

i) Attix5 Pro SE and the MS SQLServer plug-in need to be installed on the actual
SQL Server and the SQL services must be running.

Run the Plug-in Installer and select the MS SQL Server plug-in to upgrade the SE Client with
the MS SQL Server plugin. After the upgrade, open the Attix5 Pro Client. You will notice a new
entry on the Backup Selection tab, in the |left-hand pane, caled
& MS SQL Server .

To add and configure a SQL  instance click on this entry

In the right-hand pane, [Slactn? Prost a0 LEE
specify the global database PN D0 @ @ @ A
dump folder for the SQL Backup | Siee Restore | Find Options | Automate | Help ATTIX Pro
. . i Backup Selection | 3 Restore | =] Logs |
instances in the MS SQL 3 Compter i [ ——
Server  Plugin section. $HZ grecyce.ain D 37
T — EW; " Plugin Description M5 SQL Server 2000/2005
You can use the Browse EZ:pEn ; Database dump Folder: ofbeckun Clont SEVESQ Backp  Browse |
erflogs lone -
button to browse to a E;ggt[gﬁm*ggfj o "
. A Sys?emVn\umeInFnrmatinn Apply Add Hew Server Instance
specific folder. " Users
-} Yindows
© 1 buahedt 15
i) Ensure that the i Jerni
server has enough TR raser
free hard drive space K
to store a data dump TR Fepotsorerangos
of all the selected bk Soar i =l
databases, Ready Last backup:03 Moy 2010 9:00:32 PM

Log Maintenance enables you to specify whether the SQLplug-in must truncate the MS SQL
logs once the backup has been completed to ensure that the log files will ot use unnecessary
disk space. Click the Apply button to add the first SQL Server instance. A sub-node will be
created in the MSSQL Server section in the lefthand pane, as displayed in the image below. Use
the MS SQL Server Instance section pane to configure this SQL instance.
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il Backup Selection | = ] R_estc-rel = Logsl

,,J My Compuber = M3 S0L Server Instance

LA
F-L $Recyde.Bin Server address: Ilocalhost
[#-}_ Book
|~ Config.Msi TCRIIP port: |1433
[ inetpub Lsername: Jsa
[+-§ . PerfLogs
WL Program Fles Eenrr I*************
[+#-} - ProgramData
-l System Yolume Information Apply | Delete this server instance
[} Users
Fp - windows

M5 SQL Setver

Qg ocalhost: 1433

MS SQL Server Instance: Last status provides information about the last connection to the
SQL Server. Enter the Server address, port, SQL usrname and password that the SE Client
must use to connect to the SQL Server.

i) You need to manually enable TCP/IP ports in the SQL 2005 Management tools.

Click Apply .

The list of the available SQL databases is populated in the lefthand pane as subnotes of the
selected instance, from where you can select the database that you want to backup. If you select
the entire section, all databases will be included, as well as any new databases created.

Selectthe database(s) that youwish to backup. Backup & Restore operations are not allowed
on the tempdb database (SQL-DMO ODBC SQLState: 42000).

To add another instance, click the MSSQL Server entry in the left -hand pane, and then click
the Add n ew server button in the right -hand MSSQL Serverplug-in section. A new node will
be added. Configure the SQLServer settings and select the necessary databases.

LY, Ensure that you have sufficient rights if protecting a remote server.

Verify that you have included all the required SQL databases in the lefthand pane before you
initiate the first backup. To create your first backup, select Backup Now on the File menu.
Attix5 Pro will create an exact copy of the selected databases in the dump folder. These files will
be compressed and transferred to the Storage Platform The next backup will compare the
selected storage groups with the selection from the previous backup, which is storedin the
cache Attix5 Pro will create a patch file for each database. This file consists of all the changes
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made to the database since the last backup. Only the patch files and any new selections will be
backed up.
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The first step is to restore the database from the Storage Platform Click on the 4 Restore tab
and select the dump folder from the specific backup date. On the File menu, click Restore .
Select a restore location and restore the database.

Open the SQL Enterprise Manager . x|
From the Console root, expand Gerwsa | Optiors |

Microsoft SQL Servers and browse to [j: Flestoee as daisbase: [SOL =]
the Server where you would like to

restore the database. Expand the Redorc € Daubace © Flegugprories & Fromdevien
databases section and select the P:;::'

database that you would like to restore. [ Sglect Devices. |
If the database does not exist anymore, T [

you have to create and configure the G?::w :@M

database first. Right-click on the s

database, selectAll Tasks and click CReobegop [

Restore Database. L e T

In the Restore as database window, e T
select the database youwish to restore.

Select From device and then click Select Devices . From the Restore from option, select
disk and then click Add . Browse to the folder where you have restored the database and select
the file.

Click OK accept the filename selected and OK again to accept the device. Using SQL
functionality, you can select how you would like to restore the backup set. You can choose
between a complete or differential database, the transaction log or file group. If you are
restoring to a new database you needto enable SQL to overwrite the database.

Click OK to start restoring the database. SQLServer Enterprise Manager will confirm that you
have successfully restored the selected database.
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The Oracle plug-in, combined with the SE Client, provides an automated backup solution for
your Oracle Database at tablespace level. The plugn will ensure that your business-critical data
is protected in case of corruption or loss. New files are automatically included for backup
without having to open the interface and selecting the files. Restore options include full media,
tablespace or datafile recovery.

i Attix5 Pro SE with the Oracle plug-in needs to be installed on an Oracle Server
and the Oracle services must be running.

To upgrade Server Edition, run the Plug-in Installer and select the Oracle 9i/10g plug-in.
After the installation open the SE Client.

ol Backup Selection | Restore = Logs Oracle Backup = Oracle Recover = Oracle Restore |
Oracle Server Settings

Server address: port: 1521

Databass name: |TESTZ

Liser rusme: 2YS

Password: | deeesssssnes
Ruetrieve tablespace names

Database backup selection

Database dump folder |C:\Program Files\AttixS Backup Profiessional SEYOradieBackup frowse |

Albwarys perform full backup. Note: Regardiess of this setting, a wesldy full backup will be enforced betwesn
Friday 7PM and Saturday TP,

¥ OO &

¥ SYSTEM |

v TOOLS

v| UNDOTES] —

v LISERS

o L

Save sebaction

Ready
It is very important to ensure that the database is in Archive Log mode . Open the
Oracle Enterprise Manager Console, right-click on the database and selectView/Edit Details
Click the Recovery tab and enable Archive Log mode and Automatic archival if it is not

enabled. The database will have to be restarted. Open thesE Client and click on the Oracle
Backup tab to configure the necessary settings.
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Oracle Server s ettings : Enter the database name, user name and passworcdhat the SE
Client will use to connect to the Oracle database. Leave the port at its default setting of 1521.
Click Retrieve tablespace names . A list of all the available tablespaces will be displayed.

Database backup selection : Select where you would like the SE Client to create the
Database dump folder. This folder is used by the SE Client to dump a copy of the selected
datafiles from where they will be backed up. The default folder is C\Program Files\ Attix5
Pro\ Backup Client SE\ OracleBackup.

i Ensure that your computer has enough free hard drive space to store a data
| dump of the selected datafiles.

Select the tablespaces that youwish to backup. Selecting the root (127.0.0.1) will backup all the
tablespaces. TheSE Client will perform a full backup of the selected files during each backup if
you enable the Perform Full Backup check box. If you do no enable full backups, it will only
backup the archive logs.

The SE Client will enforce a weekly full backup between Friday 7PM and
Saturday 7PM.

N
~

Click Save selection. The SE Client will not back up the selected datafiles if you do
not save the selection

Your Oracle Server Backup is now configured. To create your first backup, selectBackup Now
from the File menu. The SE Clientwill create a hot backup of the selected datafiles in the dump
folder. These files will be compressed and transferred to the Storage Platform The next backup
will compare the selected storage groups with the selection from the previous backup, which is
stored in the cache. The SE Clientwill create a patch file for each datafile. This file consists of
all the changes made to the datafile since the last backup. Only the patch files and any new
selections will be backed up.

You have the option to either recover or restore Oracle tablespaces or datafiles. If yourecover
the datafiles, The SE Clientwill ensure that the tablespace or datafile is offline, restore the data
to its original place, recover the data and place the datafiles online again. This cannot be
done with the System tablespace, as it has to be online when you restore it.

The first step is to retrieve the files that you want to restore from the Storage Platform. Click the
4 Restore tab and select the dump folder from the specific backup date. On the File menu,
click Restore . Select arestore location  (do not restore to the original location) and ensure
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that you selectthe recreate the directory structure check box. Restore te files. After the
files have been restored, open theOracle Recover tab.

Oracle Server Settings : Supply the Oracle database name and your user name and password
that you use to connect to the Oracle datatase. Server Restore selection : Use the Browse
button and select the Recovery Folder where you restored the data from theRestore tab.

Click Retrieve Tablespaces . A list of the available tablespaces and datafiles will be displayed.
Select the datafilesthat you wish to recover and click on Recover .

The files will be taken offline, the data will be restored to their original locations and the files
will be recovered. The SE Clientwill place them online after they have been recovered.

If the restore dialog window displays any warnings or errors in red,
it is probably requiring a log file that is not located in the default location. In such a
case, you need to perform a manual recovery using SQL Plus, as described below.

N
~

Follow these steps if the Recovery Tab restore process failed.

1. Open SQLPIus and log in as sysadmin

2. Run the command Alter database recover cancel;

3. AndthenRecover datafilbblee bpmpadhed o t a

4. Follow the on screen prompts. You may be asked to supply the path to specific log files.
These log files form part of the backup selection and would have been restored to the
specified dump folder during the restore process. If you cannot find it, search for the
missing log files in the backup history. You can either supply the path (remember to use
inverted commas) or copy the files to the Oraclefolder listed in the error message.

5. Next you must setthe database to online again withAl t er dat abase datafil e ¢
table space.dbfodo online;

6. The last step is to open the database withAlter database open;

7. The Oracledatabase will be opened and ready.
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E 3 If you see the follow error, or something similar as the
log names will not be the same, you must follow the above-mentioned steps to recover
the database.

[3) Oracle Restore Dialog =

Start of restoration

Restoring archive logs

Restoring database files

Error recovering datafile ORA-00279: change 3184658 generated at 04/09/2008 17:11:02 needed for thread 1 ORA-00239: suggestion
CHORACLEXEVAPPYORACLE\FLASH_RECOVERY _AREALREVARCHIVELOGIZ008_04_15401_MF_1_7_%l_ ARC ORA-00280: change 318468 for thread 1
is in sequence #7 CORACLEXE\ORADATA\XEYSERS . DEF

Error getting datafile online ORA-01113: file 4 needs media recovery ORA-01110: data file 4: 'CAORACLEXEVORADATAVSEYISERS, DEF

Deleting archive logs

Run the command Alter database recover cancel,
AndthenRecover dataaklexé toradata: \xe\users.db f 6 ;

SQL> recover datafile 'C: \ oraclexe\ oradata \ xe\ users.dbf’;

ORA-00279: change 318468 generated at 04/09/2008 17:11:02 needed for thread 1
ORA-00289: suggestion :

C:\ORACLEXE\APP\ORACLE\FLASH_RECOVERY_AREA\ XE\ ARCHIVELOG\ 2008_0
4 15\01_MF_1_7_%U_.ARC

ORA-00280: change 318468 for thread 1 is in sequence #7
Specify log: {<RET>=suggested | filename | AUTO | CANCEL}

If you hit RET, it will automatically try to use the suggested file, as specified in the
example. If the file is not available in t he folder, a message will be displayed:

ORA-00308: cannot open archived log
'C:\ORACLEXE\APP\ORACLE\FLASH_RECOVERY_AREA\ XE\ ARCHIVELOG\ 2008_
04 09\01_MF_1 8 3ZSQ4MML_.ARC'

ORA-27041: unable to open file

0OSD-04002: unable to open file

O/S-Error: (OS 2) The system cannot find the file specified.

If the file cannot be found you have two options. Either point SQL Plus to the
Recovery folder with the filename command, or you can copy the file into the
required Oracle folder,
C:\ORACLEXE\APP\ORACLE\FLASH_RECOVERY_AREA\ XE\ARCHIVELOG\ 2

008_04_09 \ in the example above.

Files are copied back to the Oracle folder in this example. Once the file has been
copied, press RET to continue.

AndthenRecover datomaclexé oracd@ia \xe\user s. dbf 6;

SQL> recover datafile 'C: \ oraclexe\ oradata \ xe\ users.dbf';
ORA-00279: change 318494 generated at 04/09/2008 17:11:10 needed for thread 1
ORA-00289: suggestion :



ATTIX®

C:\ORACLEXE\APP\ORACLE\ FLASH_RECOVERY_AREA\ XE\ ARCHIVELOG\ 2008 _0
4 _15\01_MF_1_8 %U_.ARC

ORA-00280: change 318494 for thread 1 is in sequence #8
Specify log: {<RET>=suggested | filename | AUTO | CANCEL}

ORA-00279: change 318498 generated at 04/09/2008 17:11:15 needed for thread 1
ORA-00289: suggestion :

C:\ORACLEXE\APP\ORACLE\FLASH_RECOVERY_AREA\ XE\ ARCHIVELOG\ 2008 0
4 15\01_MF_1 9 %U_.ARC

ORA-00280: change 318498 for thread 1 is in sequence #9

ORA-00278: log file

'C:\ORACLEXE\APP\ORACLE\FLASH_RECOVERY_AREA\ XE\ ARCHIVELOG\ 2008_
04 _09\01 _MF_1 8 3ZSQ4MML_.ARC' no longer ne eded for this recovery

Specify log: {<RET>=suggested | filename | AUTO | CANCEL}
Continue with the Recover d a t\ardclieXe e oradat: \xe\us er s .
command and supplying the log files until you see the following message

é

Specify log: {<RET>=suggested | filename | AUTO | CANCEL}

Log applied.
Media recovery complete.

Alter database datafile 'C: \oraclexe \oradata \XE\users.dbf online;
Database altered.
alter database open;

Database altered.
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The first step is to retrieve the files that you want to restore from the Storage Platform. Click the

4 Restore tab and select the dump folder from the specific backup date. On the File menu,
click Restore . Select a restore location and restore the files. Do not recrete the directory
structure.

\ || Backup Selection || Restore Logs Oracle Backup Oracle Recover Oracle Restore |
Server Restore Selection

Recovery Folder C:\Program Files\AttixS Backup Professional SE\OracleBackup | . Browse '
. Retrieve Tablespaces l
|_| Restore control files

B 127,001

[ TEMP
[¥] CWMLITE
[_| DRSYS
| ] EXaMPLE
[} DX
| ] oDmM
[v] SYSTEM
[v) TOOLS
[} uNDOTBS1

=

B BEEBE

B &EBE

V] USERS =

[1 ¥NR e |

=

Restore

There are a few different scenarios when recovering an Oracledatabase, tablespace or datafile.
After you have selected the recoveryfolder (the folder to where you restored the data) click on
Retrieve Tablespaces . A list of the available tablespaces will be displayed. Restore control
files must be enabled when you do a full restore. When you clickRestore , the SE Client will
remind you to make sure that the database is offline. If you are only restoring a few datafiles,
make sure that they are offline before continuing. Change the necessary settings and click
Restore . The SE Client will restore the selected files to their original location but they will not
be recovered. After theClient has restored the files, you have to manually recover the files and
start the database.
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The following examples provide some assistance if you prefer to restore the data using SQIPlus.
Please note that these are advanced Oraclsettings and that you need the required Oracle skills
to attempt any of these options.

Recovering a Closed Database

Media or hardware failure :

1. Determine which datafile or datafiles need to be recovered.

2. Shutdown immediately .

3. Open the SE Client and restore the dump directory from the Storage Platform. Open
the Oracle Restore tab and select the files thatyou want to restore. Click on Restore .
Open SQLPIus with the following command: sqlplus /nolog
Connect / as sysdba
Mount the database with the startup mount ; command
Recover datafile 'c: \data \ datafilel.dbf' ; or recover tablespace
tablespace name; or recover database;

8. Open database

N o o ks

Recovering a Opened Database

Media or hardware failure (Not the System Tablespace):.

1. Determine the datafile or datafiles that need to be recovered.

2. Opensqlplus /nolog and connect /as sysdba

3. Take the datafile offlin e alter database datafile ‘filename' offline;

4. Open the SE Client and restore the dump directory. Select the datafile that you want to
restore.

5. Recover datafile 'c: \data \ datafilel.dbf' ; or recover tablespace
tablespacename ;

6. Bring the tablespace or datafile online (Step 16 in the next sectioni Recovery/Full
Recovery)

Recovering a Database

Media or hardware failure (System Tablespace)

1. Unlike other tablespaces, the SYSTEM tablespace must be available in order to open the
database. Therefore, if any membes of the system tablespace are damaged, they must be
restored now. Before doing this, make sure that the database is not open. It may be
mounted. To make sure, run the following command on the mounted, closed database.

2. C:\Oracle\ Ora92\ bin> sqlplus / nolog

3. connect/ as sysdba
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4. select status from vSinstance ; The following will be displayed:

STATUS
MOUNTED
1 row selected.

5. If the database is not open, restore the damaged files from the most recent backup
available restore dump directory and select the datafiles. Once all damaged files in the
system tablespace are restored, run the following command on the mounted, closed
database:

6. recover tablespace system

7. alter database open ;

8. quit

Full Media Recovery

Recovery to the same locaton:

1. Open SQLPIlus and stop the database with theshutdown abort;  command.

2. Open the SE Client and Restore the entire dump folder from the Storage Platform. Open
the Oracle Restore tab and restore all files including the control files.

3.  Mount the database in SQL Plus: startup mount

4. Recover database using backup controlfile; Accept the default path that is
suggested when restoring the log files. If the last log file cannot be located run the reover
database using backup controlfile; command again and supply the path to the redo folder
that you restored as well as the filename of the redo log file within that folder.

5. Alter database open resetlogs;

6. The Oracledatabase will be opened and ready.
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The Script plug-in enables you to execute scripts and batch files during the backup process. This
allows you to prepare an application for backup and to create a data dump of a database. ®u
can also stop and start applications or services before, during or after any backup.

Installing the Script plug -in

To install the Script plug-in, run the Plug-in Installer and select the Script plug-in. After the
installation, open the SE Clientinterface.

Configuration and Use

[SYScripting settings To add scripts, open the Tools menu, select

Scripts Plug -ins and click on Scripting

| Script Mame | Add |
— | The Scripting settings window allows you to
Add new and Edit or Delete existing scripts.
ﬂl Click on Add to create a new script.
Ok Cancel |

[31Add new script Start by supplying a Script
Stript name: [Seriptt name and specify when this

Run script on event: [Backup start =] script should run.

Excecute: Browse
(Compression and patching

Backup data created
(Connection open

Transfer start

Transfer end

(Connection closed

[~ Abort backup i eggackop end hd

Execute in Folder: Browse

i)

Paramekers:

W Wait For process

ok | Cancel

You can choose between:
Backup/Restore start/end
Backup data created
Connection open/closed
Backup/Restore Transfer start/end
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Browse to the application or batch file that should be executed. Supply a location where it
should be executed as well as any otheParameters needed.

Specify whether you want the SE Client to wait for the process to be completed before
continuing with backup process by enabling the checkbox next to Wait for process to
complete .

Click Ok to save the new script. You can enable/disable scripts by clicking in the checkbox next
to the Script Name. After you have configured all your scripts, click Ok to close the Scripting
settings window.
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The Attix5 SharePoint 2003/2007/2010 plug-in provides protection for Content and individual
document/item s of MS SharePoint 2003 (including SharePoint Services 2.0), MS SharePoint
2007 (including SharePoint Services 3.0) and MS SharePoint 2010.

The default option to install the Attix5 SE Client service is as local system user but the Local
Windows system user account cannot be given access rights in SharePoinand the SE Client
Service should therefore be configured to run in another account other than System.

A Windows (or domain) user must be created that will only be used to run the SE Client service.
This user should be made a member of the Backup Operators group and should beprotected
with a strong password as it will be given full rights in SharePoint .

Once the user has been created, it should be given th&ite Collection Administrator role in
SharePoint using the SharePoint interface. This should be done for all Site Collections that need
to be backed up.Remember to include any Shared Services Provider (SSP) Site Collections in
this step. Failure to do so will result in errors when trying to back -up the SSP Web Applications
in your farm.

The user needs rights to read the registry.

The specific keythat needs to be read from the registry for SharePoint 2010 is:
LocalMachine\ SOFTWARE\ Microsoft\ Shared Tools Web Server Extensions 14.0\ Secure,
ConfigDb\dsn

The specific key that needs to be read from the registryfor SharePoint 2007 (WSS 3.0) is:
LocalMachine\ SOFTWARE\ Microsoft\ Shared Tools Web  Servel Extensions\ 12.0\ Securé
ConfigDb\dsn

The specific key that needs to be read from the registryfor SharePoint 2003 (WSS 2.0) is:
LocalMachine\ SOFTWARE\ Microsoft \ Shared ToolssWeb Server Extensions Securé
ConfigDb\dsn

In addition, this user must be given db_owner role  (using SQL Management Studio) to the
Config database and all Content datatases that need to be backed up.



ATTIX’

The abovementioned user (as well as the SQLServer service user)should also be givenRead
and Write file system rights to the dump folder as specified in the Attix5 SharePoint plug-in
interf ace.

i The dump folder itself is deleted and created again before being used, so if a UNC
path is used, the actual dump folder must not be a shared folder (this will cause an
access violation).

Example, the UNC path should be as follows: \\ server\ share\dump where dump can be
deleted by the user mentioned above. Specifying \\server\share as the dump folder
might cause access violations, because the service will then try to delete the share itself.

The steps should ensure hat backups and restores can be done without access problems.

To summarize:
1. Special user for running the Attix5 service.
Strong password.
Site Collection Administrator role for all Site Collections.
Db_owner role for Config and Content databases in SQLServer.
File system rights in dump folder for Attix5 and SQL Server services
Dump folder should not be a share itself, but can be a subfolder in a share.

o0 s wN

e

The SharePoint 2007 and 2010 Attix 5 plug-in require s the installation of .NET 3.5
SP1 This applies for SharePoint 2003 /2007/2010 when using the Attix5 SharePoint
plug-in V3.0 and above. This requires that .NET be installed prior to any upgrade of the
previous 2003 SharePoint plug-in.

e

Attix5 Pro SE and the Attix5 SharePoint plug-in must be installed on a physical
SharePoint server that is joined to the farm that is required for backup.

Please refe to the additional i n f Astixm 8hareRoint
Disaster Recoveryoguidelin e.

Run the Plug-in Installer and select the SharePoint  plug-in to add the plug-in to the existing
SE Client. After the upgrade, open the client.

After the installation , a new node a EackupSelecﬁml & Restore | (] Loos|
will be available in the left-hand 3 My Computer
pane, called Share Point Farm . B C:
. . . [+ g MS SQL Server
The plug-in  will automatically =k Sharepoint

[#1 L {Web Application} Default S5P
[=} [ {web Application} portal, synergy.com
[=- & {Content Database} SP_Portal_Conkent
= 1o {Sike Collection} http: jiportal. synergy.com
=15 {Web Sike} http:ffportal.synergy.com
& {3ite Collection} http: jjportal.synergy.com/dema
[ {5ite Collection} http:/fportal. synergy.comfbr
5 15ite Collection} http: [fportal. synergy . com My Site
5 {5ite Collection} http: /iportal. synergy. comjpersonalfadminist

communicate with the SharePoint

- - (- [
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farm using the SharePoint APIs and then retrieve and display a hierarchy of content in the tree.
As seenin the image on the left, individual files are displayed on the right -hand side.

Browse through the available nodes and select the items that you want to backup as you would
select files and folders in the default Backup Selection tab. Once you have made your
selection, you can click the Backup toolbar button to initiate the first backup.

Restoring SharePoint data is as simple as selecting the applicable SharePointhode and the
required sub-nodes in the left-hand pane and then any individual files, if needed. The plug-in
does the rest.

: Open the & Restore tab,
& Backup Selection HR_ES':UVEI =] Lngsl

4l Backups Sharepoint Entity Details select the required databases
=i Last Backup (22 Jan 2010, 16:24:44 . . .
& ETS M:‘CSQl S(erve?llugin ! Entity Type  Contenk Database and files in the SharePoint
B # Shareport Saia ol i section and then click on the
4|5 {Web Application} Default SSP
=& {web Application} portal.synergy.com Restore button in the

B {Content Database} SP_Portal_Content
ik workspace toolbar .
[(-§— Previous Backups

Specify the restore location, and then click Ok. The SE Client will restore the files to the
specified location and the SharePoint plug-in will pick up the files and restore it to the
SharePoint server.

Once the restore is completed confirmation will be supplied in the Restore dialog box and the
log file.

For a complete Disa ster Recovery , first reinstall SharePoint, then select the complete
SharePoint node and do the restore.

i For Disaster Recovery, the server being restored to must have the same hostname
- | as before. Please refer to the additional inf or mati on provided in
Di saster Recoveryo guideline.
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When the System State plug-in is selected for installation, two plug -ins are actually installed.
The plug-in used to perform a System State backup or restore depends on the operating system
that i tirgstslled on:

System State (using WSB) for Windows 2008 and later

System State(using NTBackup) for operating systems prior to Windows 2008

N
~

The VSS plug-in sometimes picks up a Sydem State writer. This writer is not
supported and should not be used. For System State backup and restore, use the System
State plug-in.

To install the plug-ins, run the Plug-in Installer and follow the steps outlined below to
completion.

e

The Attix5 Pro Server Edition Client must be installed on the computer before you
can install any plug -ins.

SE plug-ins require working space for the cache and disk space for creating a data
dump and patches.

Step 1: Specify Backup Client folder location

1. Ensure that the correct Backup Client folder location is selected. If not, click the
Browse button, select the correct folder, and then click OK..
2. Click Next .

Step 2 : M odify plug -in selection
1. Selectthe System State check box

2. Click Next .
System State

[ YMware20 [ESX 3.5)
(] WMware5 [ESX 3.5)
[ ¥Mware50 [ESX 3.5)
[ WMwarePlus (ESX 3.5)
[  ¥SS [Exchange 2003/7/10, MS SOL 2005/8)

ATTIX’Dro

Attiws nstaller
Back | Nest l Close |




ATTIX®

Step 3: Apply changes
On the Summary page, click the Apply requested changes  button, and then click Next .

Step 4: C lose Plug -in Installer

Click Finish to close the Plugin Installer .

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.













































